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Hover the mouse pointer over the Home Tab icons and you will see a message telling you what that
icon does. If there is a keyboard shortcut also available for this function, it will tell you what it is.
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Small box to the left of the Home Tab:

Hover the mouse pointer over the box. It will tell you that it contains functions that enable you to
open, save, print or do other options to your document.

Click on the down arrow beside the small box to open up the Menu:

New: (this will give you a new WordPad screen). (Another option is: CTRL + N)

Open: (This will open an existing document) (Another option is CTRL + O).

Save: (This function is used when you make changes to an existing document, and you want to re-save
the document with the changes). (Another option is CTRL + S)

Save As: (You must use this option first to give your document a name and to tell the computer what
format you want to save your document into). (The right pointing arrow will take you to five
different ways you can save a document).

Print: (This option allows you to print a document in three different ways: Select printer and number
of copies and print, Quick print (straight to the printer), or Print Preview (which allows you to see
your document as it will be printed) (Another print option is CTRL + P)

Page Setup: (This is where you can select the paper size and source, portrait or landscape, margins
(top, bottom, sides), and print page numbers. (Un-tick box if you don't want this option).

Send in an Email: (Enables you to send your document as an email attachment).

About WordPad: (Statistical data about your version of WordPad).

Exit (Allows you to exit WordPad and closes down your WordPad screen).

HOME TAB:
The Home Tab has five groups: Clipboard, Font, Paragraph, Insert and Editing.

Clipboard Group: Three options are available: Cut, Copy, Paste.

e Cut (will remove highlighted text from a document and save on to Clipboard). (Other options
are: CTRL + X or Right mouse click, Cut).

e Copy (will leave highlighted text where it is, but copy it so you can also place it elsewhere on
your document). (Other options are: CTRL + C or Right mouse click, Copy).

e Paste (allows you to paste both the highlighted cut or copied text wherever you choose). (Other
options are CTRL + V or Right mouse click, Paste). Note the down arrow beside the Paste
function. Paste and Paste Special are now available. Paste Special options also include ALT +
CTRL + V). You use Paste Special for text with links to the Internet, pictures, drawings etc.

WordPad Page 1 of 6



Font Group:

e  Font style (Calibri is default setting). Click on down arrow for other font styles.

o Fontsize (12 is default setting). Click on down arrow for other font sizes.

e Capital A and Small A: (The capital A will enlarge the highlighted text font size; the smaller A will
reduce the highlighted text font size).

e B will Bold text. (Another option is CTRL + B).

e | will Italicise text. (Another option is CTRL + 1).

o U will underline text. (Another option is CTRL + U).

e abc (strikethrough). Places lines through text to indicate it is to be deleted.

e X, (used for subscript). (Another option is CTRL + =).

e X’ (used for superscript) (Another option is CTRL + Shift +)

e Pencil (text highlighter). Will highlight text as if you had used a highlighter. The down arrow will
give you the choice of 12 different colours.

e The A will change . by clicking down

Paragraph Group:

e Left arrow (will move indented, bulleted or numbered text to the left of the page).

e Right arrow (will move indented, bulleted or numbered text to the right of the page).

e Three dots (bullet and numbered points. Press the down arrow beside the bullets to see other
options).

o Double headed arrows and lines (sets line spacing and indents).

Four square boxes with lines: Lines show position of text on your page.

e Box 1: Left justified - Text starts at left margin. (Another option is CTRL + L).

e Box 2: Text is Centred. (Another option is CTRL + E).

e Box 3: Text is right aligned (but not left aligned). (Another option is CTRL + R).

e Box 4: Text is justified - both right and left aligned. (Another option is CTRL + J).

The Insert Group:

e Picture: You can insert a picture. Click on down arrow to change or resize a picture.

e Paint drawing: you can insert a paint drawing you did in Microsoft Paint. (Another option to
insert a drawing from MS Paint is CTRL + D).

e Date and Time: Click on icon for a small selection of date/time styles.

e Insert object: You can insert a graph, text etc from other Microsoft packages.

Editing Group:

e Find: You can use this function to help you find text quickly in a document. (Another option is
CTRL +F).

e Replace: The replace option enables you to both find text in a document and replace it with
another word. (Another option is CTRL + H or the special function key F5).

e Select All: This function selects all the text in the document. (Other options are CTRL + A, or click
and drag the mouse over the text to be selected).

VIEW TAB: Click on the View Tab to see three groups: Zoom, Show or Hide, and Settings:
Zoom:

e This allows you to zoom in (increase text size); size/zoom out (reduce text size); or set for 100%.

Show or Hide:
e Tick to show the ruler (measurements on top of your document). Un-tick to hide the ruler. Tick
to show the Status Bar (bar at the bottom of your document); Un-tick to hide the status bar.
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Settings:

e  Word Wrap: Click on the down arrow to change the way your page looks. You can have three
different views: no wrap, wrap to window, or wrap to ruler. Word Wrap will not affect the
printing of your document.

e Measurements units: You can set your computer to work in inches, centimeters, points or picas.

ADDITIONAL WORDPAD TOOLS

Upper left corner: Quick Access Toolbar (QAT):

e This toolbar appears on every Microsoft document. You can add features you use frequently, or
delete the ones you don't. To add an icon to the QAT, right mouse click on the icon, and you will
see a drop down menu. Select Add to QAT. You can also choose to place the QAT underneath
the Ribbon. The Ribbon is where you see Home and View tabs. You can also minimize the
Ribbons so they are not visible (giving you more document space to see your document). To
bring the Ribbons back again, remove the ticks in the Minimize Ribbons box.

Upper right corner: Three function icons:

o The first icon will minimize your document and place it on the bottom Taskbar.

e The second icon will restore your document screen to full size, or reduce it partly so you can add
a second document alongside the first document and view two or more documents at the same
time.

e The third icon (X) will close your document and take you out of WordPad.

The question mark underneath the three function icons represents HELP. Click on the ? and view a
mini tutorial on WordPad, plus find help with other WordPad topics.

The Scroll Bar: This is the white bar on the right side of your screen. You can scroll your document
up or down the page by clicking on the middle of the scroll bar, and dragging it up or down, or you
can roll the scroll button on your mouse. The top and bottom arrows on the scroll bar will move your
document up or down one line at the end of each click. Page Up and Page Down on your keyboard
will move text up or down one page at a time.

The Ruler: This is the measurement bar you can see on the top of your document. You can drag the
margin markers in or out to widen or reduce the margins. You can click on any number on the Ruler,
and a tab marker will appear. If you press the TAB Key on your keyboard, your cursor will stop at
every Tab marker. To remove a Tab marker, click and drag it down off the ruler.

The light coloured bottom Status bar: This contains another zoom control lever, which enlarges or
reduces your text.

The dark blue coloured bottom Taskbar: From left to right:

Contains the Start button; sometimes some icons, any documents you have minimized; and in the
systems notification area, you will find information such as time, volume control, antivirus package,
plus other program icons you may have placed on your computer. You can hover over the icons to
see what they are.
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SOME KEYBOARD SHORTCUTS - WORDPAD

Formatting Text

Ctrl + B = Format the selection with Bold.

Ctrl + I = Format the selection with Italics.

Ctrl + U = Underscore (underlines) the selection.

Ctrl + Shift + D = Double-underscore (underline) the selected text.

Ctrl + Shift + W = Underscore (underline) only words (not spaces) of the selected text.
Ctrl + = = Change the selected text to Subscript.

Ctrl + Shift + = = Change the selected text to Superscript.

Ctrl + D or Ctrl + Shift + F = select the text first, then press Ctrl + D to open the Font
window

Ctrl + Shift + A = Change the selected text to all CAPS. If text is already capitalized, will
change to no CAPS.

Ctrl + Shift + K = Change the selected text to small CAPS. If shortcut pressed again, will
change to no CAPS.

Working With Text

Ctrl + C = Copy the selection to the Clipboard.

Ctrl + V = Paste the selection from the Clipboard.

Ctrl + X = Cut the selection.

Ctrl + Z or Alt + Backspace = Undo the last action. Can be pressed multiple times to undo
multiple actions.

Ctrl + Y = Redo the last action.

Ctrl + A > Select all text in the document.

Ctrl + E = Center the text in the paragraph that the cursor is in, or center the selected text.

Ctrl + L = Left align the text in the paragraph that the cursor is in, or left align the text in the
selected text.

Ctrl + R = Right align the text in the paragraph that the cursor is in, or right align the text in the
selected text.

Ctrl + J = Justify the text in the paragraph that the cursor is in, or justifies the text in the
selected text.

Ctrl + M = Indent the text. If no tabs are set, default indent is .5 inches. Press Ctrl + M
repeatedly to indent repeately.

Ctrl + Shift + M = De-indent the text. Press Ctrl + Shift + M repeatedly to de-indent

Ctrl + K = Insert a hyperlink - a link to a webpage.

Alt + Shift + D = Enter the current date from your computer.

Alt + Shift + T = Enter the current time from your computer.

Working With a Document

Ctrl + Home = Move to the beginning of the document.

Ctrl + End = Move to the end of the document.

Ctrl + F = Display the Find window.

Ctrl + H = Open the Replace window.

Ctrl + Enter = Insert a Page Break where the cursor is.

Ctrl + S = Save the document. Get into the habit of pressing this key sequence often so you
won't accidentally lose your work.

Ctrl + P = Open the Print window.

Ctrl + W or Alt + F4 = Close the document. Only Alt + F4 works in Microsoft WordPad.
Ctrl + O = Open an existing document.

Ctrl + N = Open a new document.
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MORE KEYBOARD FUNCTIONS

Home key will take the cursor to the start of a

line

End key will take the cursor to the end of a line

Delete key will delete text one space to the right

Backspace key will delete text one space to the left

Insert key will stop text being added, and will
‘gobble up’ the words you input

Enter key will take cursor to the next line. Pressed
twice it creates a new paragraph

Shift key will enable you to type the characters
on the top of each key

Tab key will move the cursor to the next tab stop

Caps Lock key will make all text type in capital

letters

The Esc key will let you cancel an error command

Ctrl key is a special function key that works with
other keys to create or modify a command

The Alt key is similar to CTRL key, and is a modifier
key

Windows key opens the Start menu

Windows key + E takes you to Windows Explorer

PageUp key moves screen up one page at a time

PageDown key moves screen down one page at a
time

Enhanced

function What it does
keys F1-F12
Close F6: Closes the document or the file in the active window.
Forward F8: Forwards the e-mail in the active window.

Function Lock

Switches between the standard function key commands (F LOCK light on) and the

(F LOCK) Microsoft keyboard enhanced commands (F LOCK light off). Leave it on or off, or
alternate between modes for increased key press functionality.

Help F1: Opens the Help system for the active window.

New FA: Creates a new document in programs that support this command.

Office Home Starts the Web browser and goes to the Microsoft Office Web site. (This is not available
on all keyboards.)

Open F5: Opens a document in programs that support this command.

Print F12: Prints the file in the active window.

Redo F3: Cancels the previous undo action.

Reply F7: Replies to the e-mail in the active window.

Save F11: Saves the file in the active window.

Send F9: Sends the e-mail in the active window.

Spell F10: Starts the spell checking program in the active document, if the document's
program has this feature.

Task Pane Shows or hides the Office task pane that was previously displayed. (This is not available
on all keyboards.)

Undo F2: Cancels the previous action.
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WORDPAD ACTIVITIES

Instruction

How to do it

Open WordPad on your computer

Click Start button; All Programs; Accessories; WordPad
OR look for it on the left program pane after you click
the Start button.

Type the following information in
the Document area of WordPad.
Hold down the SHIFT key to make
capital letters. Press the space bar
to create spaces between words.

I am happy to learn how to use WordPad to write
letters. | can also attach pictures in WordPad. It will be
good when it comes time to send out my Christmas
newsletter.

Add these words exactly as they
are written here:

I love makeng mistakes in
WordPad becouse it means | cin
learn how to fix them.

Correct all errors by pressing the backspace key on
your keyboard to correct errors one space to the left
of your cursor, and the delete key on your keyboard to
correct errors one space to the right of your cursor.

Highlight the words: Wordpad,
using three different methods:

Method 1: Highlight by clicking in front of the letter W.
Hold down the left mouse button while you drag your
mouse over the word. Release the mouse button.
Method 2: Place your mouse cursor in front of the
letter W, and hold down the SHIFT key while you press
the right directional arrow on your keyboard.

Method 3: Place your mouse pointer on the word to
be highlighted and double click the left mouse button.

Using the bold function in two
different ways:

Bold words in your document using each of the
following methods:

Highlight the word, and click on B (for bold) on your
Home ribbon tab.

Highlight the word, then hold down CTRL key and
press the B key.

Colour different words in your
document (one word at a time)

Highlight a word in your document. Press the down
arrow beside the capital A with a coloured line
underneath. Click a colour.

Change the font style and font size
of your document

Highlight all the words in your document by holding
down the CTRL key and pressing A.

Change both the font style and size by clicking on the
down arrows beside Calibri (font style) and 12 (font
size). Change to Arial, 14 point.

Insert the word very into your
document before the word happy

Position the mouse cursor before the word happy and
type in the word very.

Create three paragraphs by adding
spaces after each full stop.

To create paragraphs, place your cursor after the full
stop and press the ENTER key twice.

Add bullet points to each
paragraph

e Highlight all the words in your document (CTRL+A).
Click on the bullet icon to add a bullet point.

Undoing your mistakes

e Press the CTRL key + Z to undo a mistake, OR
e Press the left facing arrow on the Quick Access
Toolbar.

WordPad
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